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1 Introduction 
 

IEEE 802.1AS, also known as gPTP (generalized PTP), specifies a highly accurate method of transferring time 

through Ethernet networks using PTP (Precision Time Protocol, defined in IEEE 1588-2008 and updated in IEEE 

1588-2019). The 802.1AS standard underlies the IEEE 802.1 Time Sensitive Networking (TSN) group of standards 

that are used in industrial automation and in-vehicle networks. The 802.1AS standard was released in 2011 and 

updated in 2020.  

 

This document outlines the key parameters and mechanisms involved with accurate time synchronization across 

Ethernet-based 802.1AS networks. A step-by-step guide is provided on how to use the Calnex Paragon-X to check 

that an 802.1AS Time Aware End Station complies with the 802.1AS profile and performance requirements. A 

section also describes how to generate impairments that simulate a network environment and evaluate the Time 

Aware End Station’s resulting clock behaviour. 

 

The descriptions in this document assume that the device-under-test (DUT) is an 802.1AS Time Aware End Station 

that outputs both a 1PPS signal and transmits Reverse Sync PTP messages. If your device only outputs one of 

these, ignore instructions for connecting and measuring the alternate signal. 

 

 

1.1 Nomenclature 

 

This document uses words and phrases consistent with the Calnex Paragon-X GUI that may differ from the names 

used in the 802.1AS standard. 802.1AS time-aware systems can be any networking device, including, for example, 

bridges, routers, and End Stations: 

 

• An 802.1AS PTP End Station is called a Time Aware End Station in the Paragon-X GUI.  

- An 802.1AS PTP End Station is either a PTP Grand Master or a recipient of PTP time information. 

- For Paragon-X operation, a Time Aware End Station always operates as a receiver of time information, not a 

Grand Master. A Time-Aware End Station implements a PTP Slave function. 

- For Paragon-X operation, a Grand Master Clock only transmits PTP time information and implements a PTP 

Master function. 

 

• An 802.1AS PTP Relay Instance is called a Time Aware Bridge in the Paragon-X GUI.  

- An 802.1AS PTP Relay Instance is a network device that receives time information from a Grand Master 

(perhaps indirectly through other PTP Relay Instances), applies corrections to compensate for delays in the 

network and the PTP Relay Instance itself, and retransmits the corrected information. 

- Time Aware Bridges have a PTP Slave function to recover the incoming clock and a PTP Master function that 

transmits time information having applied corrections to compensate for delays in the upstream network and 

the Time Aware Bridge itself. 
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2 802.1AS Timing Mechanisms 
 

Time synchronization across 802.1AS networks uses the IEEE 1588 Peer Delay message exchange and Logical 

Syntonization mechanisms. Logical Syntonization is a mathematical method of correcting for varying oscillator 

frequencies in the path between Grand Master and End Station. A brief overview of the messages and Logical 

Syntonization mechanism is provided in Appendix A. Please refer to the following standards documents1 for full 

details and specific requirements: 
 

• IEEE 1588-2008 – IEEE Standard for a Precision Clock Synchronization Protocol for Networked Measurement 

and Control Systems. 

• IEEE 1588-2019 – IEEE Standard for a Precision Clock Synchronization Protocol for Networked Measurement 

and Control Systems. 

• IEEE 802.1AS-2011 – Timing and Synchronization for Time-Sensitive Applications in Bridged Local Area 

Networks. 

• IEEE 802.1AS-2020 – Timing and Synchronization for Time‐Sensitive Applications. 

• AVNU 802.1AS Recovered Clock Quality Testing rev 1.0 Oct-2016. Download here. 
 

Using the IEEE 1588 Peer Delay mechanism and Logical Syntonization allows 802.1AS equipment to avoid the need 

for high-cost TCXO or OCXO oscillators and hardware PLLs. During steady state operation, 802.1AS equipment 

maintains synchronization to within 1µs across a network of seven hops. 802.1AS timing mechanisms can rapidly 

recover from network changes. 

 

The AVNU document listed above proposes that 802.1AS Time Aware End Stations may send Reverse 

Synchronization messages instead of, or in addition to, outputting a 1PPS signal to expose the End Station’s internal 

time. External test equipment can monitor the Reverse Sync messages and 1PPS signal to validate that the End 

Station correctly recovers time. Reverse Sync is useful in End Stations that do not have a 1PPS test output and End 

Stations that are difficult to reach in an industrial or in-vehicle network.  

 

 

2.1 Key metrics for Accurate Operation of the 802.1AS Timing Mechanism 

 

Several metrics are key to the successful operation of Logical Syntonization in an 802.1AS network:  

• Accurate assessment of upstream link propagation delay by Time Aware Bridges and Time Aware End Stations. 

• Accurate calculation of residency time in Time Aware Bridges. 

• Accurate calculation of Neighbour Rate Ratio (NRR) and rateRatio by Time Aware Bridges and Time Aware End 
Stations. NRR is the ratio of the current device clock compared to its upstream neighbour, rateRatio is the ratio 
of the current device clock compared to the Grand Master clock. The rateRatio number is encoded and carried 
in the Cumulative Scaled Rate Offset (CSRO) field of Sync Follow-Up messages. 

• 802.1AS defines local clock resolution as less than or equal to 40ns (802.1AS-2020 section B.1.2). This defines 
the quantization level for synchronization calculations. 

• Jitter and wander time noise generation of local device clocks are specified in 802.1AS-2020 section B.1.3.   

• Residency time across 802.1AS Time Aware Bridges must not exceed 10ms (802.1AS-2020 section B.2.2).  

• Peer delay message turnaround time must be less than 10ms (802.1AS-2020 section B.2.3).  

• 802.1AS specifies that rate ratio measurements must not exceed ±0.1ppm (802.1AS-2020 section B.2.4).  

• 802.1AS specifies that end-to-end time error between a Grand Master and Time Aware End Station should be 
less than ±1µs across seven network hops (802.1AS-2020 section B.3).  The standard does not break down the 
time error budget per device. 

 

 
1 IEEE standards are available for purchase at https://www.techstreet.com/ieee.  

https://avnu.org/wp-content/uploads/2014/05/Avnu-Testability-802.1AS-Recovered-Clock-Quality-Measurement-1.0_Approved-for-Public-Release.pdf
https://www.techstreet.com/ieee
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The diagram below shows a few locations where calculation or timing errors may occur in 802.1as network devices. 

Tests using the Paragon-X can help to debug the sources of time error. 

 

 
 

The dotted red lines indicate the timestamping planes inside the devices, typically implemented in embedded 

software on 802.1AS Time Aware Bridges and End Stations. Hardware timestamping moves the timestamp planes 

to the edge of the device where it is unaffected by variation in software execution time, so improves timestamp 

accuracy. 

 

Referring to the diagram, sources of error include: 

Q – Timestamp quantisation noise. Oscillator frequency jitter and wander. 

A – Accuracy of latency between physical ports and timestamp planes. 

B – Accuracy of Sync message Residency Time in Time Aware Bridges. 

C – Accuracy of Peer Delay turnaround time calculations. 

D – Accuracy of Sync message to 1PPS and Rev Sync transmission in Time Aware End Stations. 

E – NRR and rateRatio calculation accuracy. 

F – Correction Field (CF) calculation accuracy. 
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3 Hardware and Software Required 
 

3.1 Paragon-X 

 

Option 111 10GbE interface support (if the DUT has a 10G interface) 

Option 201 Advanced IEEE1588v2 features 

Option 205 Wander measurement 

Option 206  Phase and time measurement  

Option 252 IEEE 1588v2 Peer-to-Peer: One-box BC, TC & OC Test 

Option 285 Reverse Sync Measurement (if the DUT supports Reverse Sync generation) 

Option 133 External 1PPS/ToD/frequency converter accessory (if required to match the DUT outputs)  

 

Paragon-X software version 30X (10.43.xx) and later 

CAT software version CAT v31.5 and later 

PFV software version PFV v31.5 and later 

 

Note: The Paragon-X 30X (10.43.xx) installer includes CAT version 31.5 and PFV 31.5. 

 

 

3.2 Accessories 
 

• SFP or SFP+ devices as required2 (user supplied). 

• 100BaseT1 and 1000Base-T1 SFPs (user supplied). The following transceivers are supported: 
- Hicotel HICSGT1FTM 100BaseT1 transceivers 

- Hicotel HICSGT1GTM 1000BaseT1 transceivers 

- Intrepid SFP-MV2112-A2 100/1000BaseT1 transceivers 

- Technica PT-1441 T1 transceivers - 100M + 1G mode 

Note that Base-T1 SFPs include signal processing and buffering functions that may affect timing accuracy. 

• Cables as required (user supplied). 

• Calnex BNC/RJ-45 adapter cable (required for 1PPS accuracy/time error measurement). 
 

 

3.3 Frequency Reference Source 
 

• Calnex Option 132, Rubidium/GPS Reference Source (optional). Provides an accurate 10MHz reference clock. 
 

 

3.4 Document References 
 

• Calnex Paragon-X Getting Started Guide CX4010 

• Calnex Cabling Considerations Document CX5009 

Both documents are accessible from the “Help” menus of the Paragon-X GUI.  
 

 
2 XFP devices are not recommended for Time Error measurements as the retiming that is an integral element of the XFP 

introduces significant uncertainty when performing a Time Error test. 
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4 Connecting Paragon-X to the Time Aware End Station (Device-under-Test) 
 

 

 

Connect the Paragon-X to the Time Aware 

End Station as shown: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Paragon-X Front Panel Ports: 

• Port 1 : 
- 100MbE Electrical or Optical (SGMII SFP) 

- 1GbE Electrical or Optical (SFP) 

- 10GbE Optical (XFP or SFP+) 

• Port 2 : unused in End Station tests 

• Upper Aux Port : 1PPS measurement 

 

 

1. Calnex recommends connecting an external 10MHz reference clock signal3 to the BNC connector on the 

Paragon-X rear panel: 

 

           
 

Paragon-X controls and measures time using the reference clock so the accuracy and stability of this reference 

signal will influence the accuracy of your test results. The Calnex Option 132, Rubidium/GPS Reference Source 

is a suitable source of a 10MHz reference clock. 

2. Connect Ethernet port 1 (Master side of Paragon-X) to the Time Aware End Station network input. 

3. Connect the 1PPS output of the Time Aware End Station to the Paragon-X upper Aux Port. Use a BNC/RJ-45 

adapter cable accessory if required, black connector. 

 

 

 

 
3 Alternate reference clocks are 2.048MHz, E1 (2.048Mb/s) and DS1 (T1) (1.544Mb/s). 
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5 Configure and Start Paragon-X Master for 802.1AS Time Aware End Station Tests 
 

The test steps listed below are described in more detail on the following pages: 
  

1. Start Paragon-X software and connect to the Paragon-X tester. 

2. Set Operating Mode. 

3. Configure physical connections. 

4. Measurement Configuration. 

5. Prepare and Start Master/Slave Emulation. 

 

 

5.1 Start Paragon-X software and connect to the Paragon-X 
 

1. Verify physical connections have been completed per Section 4 of this document. 

2. Start the Paragon-X GUI. 

3. Select Start Up and Connect. 

4. Enter the IP address of Paragon-X (displayed on the Paragon-X status display) and click OK. 

5. See Paragon-X Getting Started Guide for more details. 

 

 
 

 

5.2 Set Operating Mode 

 

1. Select Operating Mode > 1588v2, check the Enable Master/Slave Emulation checkbox then Close. 
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5.3 Configure Physical Connections 

 

1. Select Setup Interface and open the Ethernet tab in the pop-up window. 

2. Ensure that TX+RX Mode is selected, then set the Port 1 Ethernet configuration to match the Time Aware End 

Station under test. The example shown here is for a 1000Base-T connection. 

3. Check that the Link status is green to indicate that Paragon-X and the DUT have an active Ethernet link. 

 

 
 

4. Select the References tab and configure a stable reference for Paragon-X. An external source is 

recommended. The 1PPS Reference Input and Reference Output parts of the tab are not required for this test. 

 

 
 

5. If testing a Time Aware End Station with 1PPS output, select the Measurement Ports tab and set the threshold 

voltage for the 1PPS measurement input. 

 

  
 

6. Close the Setup Interface pop-up window. 
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5.4 Measurement Configuration 

 

1. Select Master/Slave/GPS Emulation. 

If the panel opens to the detailed configuration panel, click the  button to show the main 

Master/Slave emulation panel, then 

a) Set Device Configuration = Master + Slave. 

b) Select 802.1AS (gPTP) or 802.1AS-2020 (gPTP) from the profile drop-down list to match the profile that 

your Time Aware End Station uses.  

c) Select Time Aware End Station from the Test Configuration drop-down list. 

 

 

 

 

2. Select Measurements, then 

a) Check the Simultaneous Measurements and Impairment/Delay option. 

b) Enable the Reverse Sync and/or 1PPS Time Error (Absolute) options as appropriate for your DUT. 

c) Close the Measurements pop-up window. 
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5.5 Prepare and Start Master/Slave Emulation 

 

1.  Select Master/Slave/GPS Emulation, then – 

a) Two options are available to compensate for delays between the DUT and Paragon-X: 

- If the Time Aware End Station hardware timestamps PTP messages at the edge of the device, enter the 

DUT to Paragon-X Ethernet Cable Delay. 
 

To correctly perform calculations, the delay caused by the Ethernet cable that connects the Paragon-X 

port 1 and Time Aware End Station must be compensated for. Values of 5.1ns per meter of electrical 

cable and 4.9ns per meter of optical cable are typical. See Calnex Cabling Considerations Document 

CX5009 for more information. 

- If the Time Aware End Station implements software timestamping of PTP messages, check the Use 

measured link delay checkbox. Paragon-X then uses the Peer Delay messages to measure and factor in 

the delay to the DUT timestamp point into the Time Error calculations. 

b) Enter the 1PPS Measurement Cable Delay. 

A value of 5.1ns per meter of cable is typical. See Calnex Cabling Considerations Document CX5009 for 

more information. 

c) Check that the Port 1 link LED is green. If the link is not up, check the Ethernet cabling, Paragon-X interface 

setup, and the Time Aware End Station interface setup. 
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2. Selecting 802.1AS (gPTP) or 802.1AS-2020 (gPTP) from the profile drop-down list configures the Paragon-X 

with a set of default 802.1AS PTP parameters suitable for many devices. Paragon-X Master PTP parameters can 

be reviewed by clicking the Configure button and changed if required. When changing Master settings, ensure 

that they remain in compliance with the selected profile by observing the displayed profile name – if Custom 

Profile is shown, settings are non-compliant and the required profile should be reselected from the menu. 

Typical parameter adjustments are: 

a) The Source MAC address that the Paragon-X master uses and the seed time for testing can be set in the 

General Settings area. 

b) Message rates and the Peer Delay MAC address can be adjusted in the Multicast/Unicast area. 

c) One- or two-step operation can be selected in the Common Header area. 

d) After reviewing the detailed PTP Master parameters, click the   button to return to the main 

Master/Slave/GPS Emulation screen. 
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3. Start the Paragon-X Master by clicking the  button: 

a) The Master is now running and connecting to your Time Aware End Station. The Master button changes to a 

red stop button. 

b) Confirm that the Paragon-X master has link-up and is receiving PTP packets (two green LEDs). 

c) Confirm that the Paragon-X is connected to your Time Aware End Station: 

- In the screenshot below, the Paragon-X master is transmitting eight Syncs per second, one Peer Delay 

Request per second, and one Announce per second to multicast address 01:80:c2:00:00:02. 

- The Time Aware End Station is sending Peer Delay Response messages from its MAC address 

12:34:56:78:ab:cd 

d) Start a capture: 

- Check the Set capture flow filter checkbox to set the capture flow filters appropriately set for an 802.1AS 

Time Aware End Station test. 

- Click the Start button in the Measurement area. 
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4. Allow the capture to run for 10-20 seconds: 

a) The status panel shows that the Paragon-X master link is up and receiving packets. 

b) PTP messages will be decoded and listed. Scroll left/right to see all message details and up/down to see all 

messages. This display is for guidance only, PFV should be used for determining protocol details and 

compliance. 
 

Note that there are no Announce messages in the capture. This is because the standard set of capture flow 

filters only captures PTP timing event messages.  

c) Verify that the 1PPS measurement status indicator is green. 

d) Initially the graph view shows captured PTP packet delay variation (PDV). You can see the 1PPS 

measurement by changing the Graph Context drop-down to 1PPS. 

e) Stop the capture by clicking the Stop Capture button. 

 

 

 

 

5. If you need to change any configuration parameters in the Paragon-X Master, click the  button in the 

Master/Slave/GPS Emulation panel. Otherwise, leave the Paragon-X Master running so that the Time Aware 

End Station’s clock remains locked. 
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6. Update the capture flow filters to include Announce messages in the Master/Slave/GPS Emulation > Flow 

Filter panel, then 

a) Select the Slave address of your DUT, or Any Multicast Slave if your DUT is not shown. 

b) Check the Announce checkbox. 

c) Click Set. 

d) Verify the six message types to capture are shown in the Flow Summary box: 

- Pdel-Req (from Master) 

- Pdel-Resp (to Master) 

- Pdel-Resp-Follow-Up (to Master) 

- Sync (Reverse) 

- Follow-up (Reverse) 

- Announce 

e) Click Start Capture. The Start Capture button uses the current capture filters including the Announce 

message. 

 

 
 

7. The capture files now include all messages that are needed to analyze the Time Aware End Station 802.1AS 

protocol operation and timing. 

 

8. Stop the Paragon-X measurement by clicking the red Stop Capture button. Unless you need to change Master 

parameters that are unavailable when PTP generation is active, leave the Master running so that the Time 

Aware End Station remains locked. 

9. Paragon-X instrument settings can be saved on your local PC using the Setup menu > Save command. The 

settings are saved as a *.cst format file that can be imported to the Paragon-X using the Setup menu > Recall 

command. 
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6 802.1AS Protocol Check 
 

The first step of testing an 802.1AS Time Aware End Station is to confirm it complies with the 802.1AS profile. In this 

test, the Time Aware End Station will connect to the Paragon-X and exchange PTP messages that will be analyzed 

using the PTP Field Verifier (PFV). 

 

1. Perform the Master/Slave Emulation Configuration steps described in Section 5 of this document: 

- Start the Paragon-X Master and check that the Port 1 link is up and receiving packets from the Time Aware 

End Station. 

- Check that the capture flow filters are set, including Announce messages. 

- Impairments are not required for this test. 

 

2. With Master Slave Emulation active, start a capture using the Start Capture button. 

 

 
 

 

3. Allow the capture to run for a minute, then use the Stop Capture button to stop the capture. 

 

  



 

 
 17 

 
calnexsol.com   | 

 

4. Select Tools > PTP Field Verifier from the Tools menu. 

 

 
 

 

PFV will launch and display the PTP messages exchanged between Paragon-X and the Time Aware End 

Station. The initial view will probably have many cells coloured red because PFV opens with a non-802.1AS rule 

set. Select and apply the relevant ruleset from the drop-down list for your equipment: 802.1AS(gPTP).xml for 

802.1AS-2011 or 802.1AS-rev(gPTP).xml for 802.1AS-2020. 
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With the relevant 802.1AS ruleset applied, you can now easily identify protocol errors. Fields of each message 

are displayed across the screen (horizontal scroll to see all the fields) with any errors highlighted in red. The 

bottom of the screen shows the result of checking the message rates. 

 

Note: a message rate of “---” indicates that either appropriate capture filters have not been set or there are no 

messages of this type being seen on the Paragon-X port 1. 

 

 
 

 

For some fields, the cause of the failure (that is, the reason why a field is flagged red) is displayed if you hover 

the cursor over the field. The example below shows an 802.1AS-2011 message exchange where the device is 

sending an incorrect PTP Version value. 
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7 Time Aware End Station Noise Generation Measurement 
 

Noise generation of a device represents the amount of noise produced at the output when there is an ideal input 

reference packet timing signal. All time-aware devices generate noise on their time signals due to hardware, 

software, and environmental factors. 
 

The tests described in this section measure the time noise generation of an 802.1AS Time Aware End Station. 

 

 

7.1 Measurement Process 

 

1. Perform the Master/Slave Emulation Configuration steps described in Section 5 of this document: 

- Start the Paragon-X Master and check that the Port 1 link is up and receiving packets from the Time Aware 

End Station. 

- Check that the capture flow filters are set. 

- Impairments must not be set for this test. 

 

2. With Master Slave Emulation active, start a capture using the Start Capture button. 

 

 
 

 

3. Allow the capture to run for at least 1000 seconds then use the Stop Capture button to stop the capture.  

 

4. Measurement data can be saved from the Paragon-X using the Export Multiple command in the File menu. The 

measurement data is saved on your local PC as a *.clxz file that can be imported to the Paragon-X software or 

read by the CAT and PFV. 
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7.2 Time Error and Peer Delay Test Results  

 

Time Error test results can be viewed while the test capture is running or after the test capture has been 

completed: 

1. In the Paragon-X GUI, set the Graph Context to CAPTURE - 1588v2. 

2. Select Tools > Calnex Analysis Tool (1588v2) > Time Error Measurement. 

 

 
 

3. The CAT opens to the file selection page and shows the 802.1AS PTP data that has been imported. 

4. In the Paragon-X GUI, set the Graph Context to CAPTURE 1PPS/GP. 

5. Select Tools > Calnex Analysis Tool (1PPS). 

6. The 1PPS measurement metrics will now be available in CAT in addition to the PTP measurements. 

7. In CAT, click the View Results button to see the initial view of the 1PPS and Reverse Sync PTP measurement 

results. 

8. You can expand the 1PPS Time Error graph by clicking the double arrow button by the 1PPS TE Absolute graph 

to expand the 1PPS measurement. 
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9. Uncheck the checkbox that applies the ±1.5µs limits to the 1PPS measurement and click the Apply button. The 

1PPS TE Absolute display will auto-scale to fit the graph area. You can enter your chosen 1PPS TE limits and 

apply them using the same user controls. 
 

The graph shows how accurately the Time Aware End Station’s clock is synchronized as reported by the 1PPS 

signal. Red vertical lines in the 1PPS Time Error graph indicate that a 1PPS signal was not detected. 

 

10. Return to the main Time Error display by clicking the double arrow button. 

 

 
 

 

11. From the main Time Error display, click the double arrow button by the Reverse Sync Time Error graph to 

expand the Reverse Sync TE measurement. Toggle the left/right or up/down arrow buttons in the Chart & 

Zoom mode area then use the mouse scroll wheel to zoom the graph in the X or Y axis until you can see 

details. Clicking the magnifier buttons also zooms the graph display. 
  

The graph shows how accurately the Time Aware End Station’s clock is synchronized to the Paragon-X as 

determined by the timestamps in the Reverse Sync messages. 
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12. In the main Time Error display, there are three graphs showing the Peer Delay Turnaround time metrics. You 

can focus on a single graph by clicking the double arrow button next to the graph that you want to analyze. Use 

the zoom buttons and mouse scroll wheel to zoom in as required. 

a) Peer Delay Turnaround Time (DUT) shows the Time Aware End Station’s own estimation of Turnaround 

Time (that is, the time taken to send a Peer Delay Response message after receiving a Peer Delay Request 

message) as determined by the timestamps in the Peer Delay Response messages. 

b) Peer Delay Turnaround Time (Actual) shows the actual Turnaround Time of the Time Aware End Station, 

measured by Paragon-X. The 802.1AS standards state that the Peer Delay Turnaround Time of Bridges and 

End Stations must be less than 10ms. 

c) Peer Delay Turnaround Time Accuracy shows the delta between the Time Aware End Station estimation of 

the turnaround time and the actual Turnaround Time as measured by Paragon-X. 

 

Further details of the Peer Delay turnaround time calculations that CAT uses are given in Appendix B. 
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7.3 Neighbour Rate Ratio (NRR) Test Results  

 

1. Neighbour Rate Ratio test results are initially not visible in CAT so click the Select Metrics button to select and 

calculate them, then – 

a) Check the Rate Ratio checkbox and click the ▼ icon to expand the group of rate ratio metrics. 

b) The rate ratio results must be calculated so click the Calculate button and wait for 100% completion. 

c) Clicking the ? icon will open context-aware help for the rate ratio calculations. 

 

 
 

 

2. Click View Results and select the Rate Ratio tab to see the Rate Ratio test results. 
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3. The 802.1AS standards specify that the rate ratio must not exceed ±0.1ppm (802.1AS-2011 section B.2.4, 

802.1AS-2020 section B.2.4). This limit is applied by default and visible as the green limit lines on the NRR 

Accuracy graph. If the NRR Accuracy meets the configured limit, a green PASS indication will be shown in the 

top-right area of the CAT window; exceeding the set limit will show a red FAIL. To remove the limits, uncheck 

the NRR Accuracy checkbox and click Apply. The NRR Accuracy graph will auto-scale for better visibility after 

removing the limits.  

 

4. You can modify the number of packets over which CAT averages the NRR calculation to match the calculation 

used by the End Station: 

a) Set the NRR Period and click Apply. 

b) Click Calculate to recalculate the NRR results. 

 

5. Three graphs show the Neighbour Rate Ratio test results: 

a) NRR Accuracy shows the accuracy of the Time Aware End Station’s NRR calculation. 

b) NRR (Actual) shows the actual NRR between the Time Aware End Station and the upstream device 

(Paragon-X). This is calculated using Peer delay messages. 

c) NRR (DUT) shows the Time Aware End Station’s internal estimation of the Neighbour Rate Ratio. 

 

6. The CSRO Delta graph shows that the Time Aware End Station has calculated its rateRatio compared to the 

network Grand Master. If the CSRO Delta graph shows a constant value, it indicates that the Time Aware End 

Station is not updating and outputting its internal rateRatio. 

 

Further details of the Neighbour Rate Ratio and CSRO calculations are provided in Appendix B. 
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8 Time Aware End Station Noise Tolerance Measurement 
 

PTP messages traversing an 802.1AS network will accumulate PDV and time errors as the messages pass through 

network equipment. Time Aware End Stations must be capable of tolerating noise on the incoming PTP flow while 

delivering in-specification timing and without losing lock.  
 

The Noise Tolerance Test involves applying a known varying delay (Time Error) profile to the PTP flow and 

measuring the effect on the Time Aware End Station’s clock. The 802.1AS standards do not specify noise limits so 

equipment vendors and network operators must define their own limits for Time Aware End Station performance 

when subject to anticipated network delays and PDV. 
 

The steps in this section describe how to use the Paragon-X to apply delay patterns that simulate network noise 

and stress the DUT. Paragon-X monitors the 1PPS and Reverse Sync outputs from the Time Aware End Station, but 

you will need to monitor the device’s internal synchronization state machine to know when changes occur (e.g. the 

device enters holdover). 

 

 

8.1 Expected Outcome 

• The Time Aware End Station should maintain reference lock until the noise exceeds your defined level for the 
End Station to switch reference or enter holdover state. The noise can be generated by Paragon-X but the state 
change must be observed from the Time Aware End Station’s management interface. 

• The performance of the Time Aware End Station’s internal clock and time calculations can be seen in CAT and 
user-defined performance limits applied. 

• If a desired Noise Transfer performance is known, then custom impairment profiles and measurement 
masks/limits can be used to confirm that the DUT meets these requirements. 

 

 

8.2 Measurement Process 

 

1. Perform the Master/Slave Emulation Configuration steps described in Section 5 of this document: 

- Start the Paragon-X Master and check that the Port 1 link is up and receiving packets from the Time Aware 

End Station. 

- Check that the capture flow filters are set. 

 

2. Click the Add Impairments/Delay button to open the impairments panel. This is where delay impairments are 

defined.  
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a) Select Delay from the Master 1 Tx list and check the checkbox. 

b) Select one of the Paragon-X built-in delay patterns and set the delay parameters as required to create your 

delay pattern. Click Generate to generate the delay pattern.  

Note: all delay patterns include a fixed delay of several µs due to the Paragon-X hardware. You may need 

to adjust the meanLinkDelayThresh parameters in the Time Aware End Station to achieve 802.1AS 

synchronization. 

c) User-defined delay patterns can be imported instead of the built-in delay patterns. User-defined delay 

patterns allow you to replay PDV patterns measured in typical networks or stress the Time Aware End 

Station with custom test patterns. Example Time Error/PDV profiles are available to download from the 

Calnex Product FAQ website. 

 

3. Click the Flow Filter button to open the panel where impairment filters are configured. Impairment filters define 

which PTP messages are impaired: 

a) Select Any multicast slave and check the Sync and Pdel-Req (to Master) checkboxes.  

b) Click Set and verify that your selected messages are listed in the Flow Summary box. 

 

 
 

4. Start the capture. PDV and 1PPS measurements will be displayed on the Paragon-X GUI and can be viewed in 

CAT as described in Section 7.2. Allow the capture to run for a few seconds or longer to provide a baseline 

measurement with no delay impairments added. 
 

5. Start applying the delay pattern by clicking the  button. 
 

6. Click the Results button to return to the measurement screen where you will see two graphs: 

- The upper graph shows the PDV of the PTP messages between Paragon-X and the Time Aware End Station. 

This is the same graph as seen when running the noise generation test. 

- The lower graph shows the delay impairment pattern and progress as the impairment is applied. 
 

7. Open CAT to see the effects of the noisy PTP signal on the Time Aware End Station: 

- 1PPS and Reverse Sync time error graphs show how the Time Aware End Station’s internal clock is affected 

by the incoming noisy PTP signal. 

- Peer Delay Turnaround and NRR graphs show how the Time Aware End Station’s internal calculations are 

affected by the incoming noisy PTP signal. 
 

8. The Time Aware End Station’s internal timing state machine status must be viewed separately, e.g. the devices 

management interface. 
 

9. Click the  button to stop applying the delay pattern. 

https://calnexsolutions.atlassian.net/wiki/spaces/KB/pages/321749039/IEEE-1588+PTP+Paragon-X+and+P-Neo
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8.3 Example Noise Tolerance Test Measurements 

 

The following two CAT screenshots show example measurements of a Time Aware End Station during a noise 

tolerance test where an 85sec burst of noise was applied to the PTP signal: 

- Noise on the Reverse Sync Subordinate Time Error and NRR graphs indicates that the Time Aware End Station 

has not filtered out the incoming noise and it is affecting the End Station’s internal clock. 

- The CSRO Delta graph shows that the Time Aware End Station has dynamically calculated its rateRatio and 

transmitted the value encoded in the CSRO field of the Reverse Sync Follow-Up messages. 

- CAT decodes the CSRO information carried in the Reverse Sync messages to calculate rateRatio and the NRR 

(DUT) metric. 
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9 Time Aware End Station Impairment Tests 
 

PTP messages traversing an 802.1AS network may be re-ordered, dropped, corrupted, or duplicated if the network 

becomes congested or traffic is re-routed around a break. Time Aware End Stations must be capable of handling 

these disturbances on the incoming PTP message flow in a safe way. The 802.1AS standards do not specify 

impairment tests or how Time Aware End Stations must handle such events, equipment vendors and network 

operators must define their own limits for Time Aware End Station performance when subject to anticipated 

network impairments. 

 

The steps in this section show how Paragon-X generates impairments that simulate network events and measures 

the effect on a Time Aware End Station’s reverse sync and 1PPS clock signals. 

 

Paragon-X monitors the 1PPS and Reverse Sync outputs from the Time Aware End Station, but you will need to 

monitor the device’s internal synchronization state machine to know when changes occur (e.g. the device enters 

holdover). 

 

 

9.1 Test Process 

 

Follow all the steps described in Section 8.2 except in step 2 where you define impairments instead of delays. 

 

Note: all delay patterns include a fixed delay of several µs due to the Paragon-X hardware. You may need to adjust 

the meanLinkDelayThresh parameters in the Time Aware End Station to achieve 802.1AS synchronization. 

 

Paragon-X can apply impairments to PTP messages both transmitted to and received from the Time Aware End 

Station. Physical corruption allows you to simulate errors on the Ethernet link including link disconnection as shown 

in the screenshot below. 
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Time measurement results can be viewed in CAT with the example below showing a series of link flaps that 

simulate cable disconnections. The vertical red lines on the CAT graphs indicate that packets have been lost and 

checking the Scatter Plot checkbox clearly shows the gaps when the link was broken. 
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Appendix A. 802.1AS Timing Mechanisms 
 

 

802.1AS PTP Messages 

 

The diagram below illustrates the set of PTP messages exchanged between a Grand Master and an End Station to 

synchronize time. 

 

 
 

• Announce messages are used to determine the Grand Master within a network and establish the synchronization 

hierarchy. The default rate for Announce messages is one per second. 

• Sync messages carry the reference time from the Grand Master out to Time Aware End Stations, traversing Time 

Aware Bridges on the way.  

- The 802.1AS-2020 standard allows Sync messages to be one-step (Correction Field appended into the Sync 

message on transmit) or two-step (Correction Field carried in Sync Follow-Up messages). The 802.1AS-2011 

standard requires two-step operation. 

- The Grand Master transmits Sync messages at a default rate of eight per second. 

• Peer Delay Request and Peer Delay Response messages are exchanged in both directions between neighbouring 
devices. 

- By counting the number of clock oscillator cycles between successive Peer Delay exchanges, 802.1AS devices can 

calculate the ratio between their local oscillator frequency and the oscillator frequencies on upstream and 

downstream neighbours. This is the Neighbour Rate Ratio (NRR) parameter. 

- Calculating NRR in both directions allows 802.1AS networks to rapidly reconfigure when there is a network change 

(e.g. new Grand Master, new device inserted, re-routed communications). 

- Devices transmit Peer Delay Request messages at a default rate of one per second. 

- Receiving devices must reply with a Peer Delay Response message within 10ms. 

- Peer Delay Response messages are always two-step so have a Peer Delay Follow-Up.  

• Reverse Sync messages (and their Follow-Up messages) are optionally transmitted from Time Aware End Stations to 
allow network monitoring and testing. 

- Reverse Sync messages have the same format and timing specifications as Sync messages, but they carry a 

specific value in the ReverseSyncDomain that is only used for testing. 
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Logical Syntonization in 802.1AS Networks 

 

A Logical Syntonization mechanism is used across 802.1AS networks from the Grand Master Clock, through Time Aware 

Bridges to the Time Aware End Stations.  
 

The Logical Syntonization mechanism allows each device in the network path to mathematically compensate for slight 

differences in their oscillator frequencies. Knowing the ratio of their local oscillator frequency to Grand Master Clock 

frequency, Time Aware End Stations can simply multiply their time by an appropriate factor to stay in synchronization 

with the Grand Master Clock. Mathematical multiplications are easily performed by modern software systems and 

removes the need for complex PLLs and servo mechanisms that are typical in Boundary Clocks. 
 

The diagram below shows the flow of messages and calculations that used in the Logical Syntonization mechanism. 

 

 
 

• Sync messages carry the Grand Master Clock time and a Correction Field (CF). The CF is updated by each Time 
Aware Bridge to add the propagation delay of the upstream network segment and the residence time of the sync 
message passing through the Time Aware Bridge. The CF carries the accumulated link delays and residence times 
that the Sync message incurred since leaving the Grand Master. 

• Each device that transmits Sync messages calculates a rateRatio number that relates how fast/slow the device’s local 
clock runs compared to the Grand Master clock frequency. The Grand Master transmits a rateRatio = 1.0. Devices 
encode the rateRatio number into a 32-bit number that is carried in the CSRO field of the Follow-Up Information TLV 
associated with the Sync message. The TLV is attached to the Sync Follow-Up message for two-step operation or 
the Sync message if the optional one-step processing is enabled. 

• Slave ports on Time Aware Bridges and Time Aware End Stations exchange peer delay messages with their 
upstream connected master. The timing of the Peer Delay Request and Peer Delay Response messages allows the 
slave port to calculate the propagation delay of incoming sync messages.  

• Time Aware Bridges and Time Aware End Stations use consecutive peer delay messages to assess the frequency of 
their local oscillator compared to the upstream sender’s oscillator frequency. The Neighbour Rate Ratio (NRR) is 
calculated. 

• Using the received rateRatio (decoded from the incoming CSRO) and calculated NRR, Time Aware Bridges and Time 
Aware End Stations calculate their local rateRatio. The local rateRatio mathematically relates the local time and 
frequency back to the Master Clock. 

• Time Aware Bridges use the local rateRatio to mathematically scale their internal clock frequency and measure the 
residency time of sync messages crossing the bridge. The outgoing Sync message CF is calculated by: 
 

Outgoing CF = incoming CF + incoming propagation delay + residency time 
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• Time Aware Bridges pass on their calculated rateRatio to the next downstream device by encoding the ratio into the 
CSRO field of the Follow-Up Information TLV associated with each sync message. 

• Each Time Aware End Station uses its local rateRatio to mathematically scale its internal clock frequency to match 
the Grand Master oscillator frequency. The End Station calculates the final link delay using the scaled clock. 

• Each Time Aware End Station extracts the origin time and accumulated link delay from incoming Sync messages. 
Adding the final link delay and Time Aware End Station residency time gives an accurate time related back to the 
Grand Master. 

• Time Aware End Stations use their internal rateRatio to scale their oscillator frequency when updating their local 
clock during the periods between Sync messages. Each received Sync message allows the Time Aware End Station 
to adjust its local rateRatio thus keeping the End Station synchronized with the Grand Master.  

• Time Aware End Stations may transmit Reverse Sync messages carrying their local time for test and measurement 
purposes. If so, they should transmit their local rateRatio encoded in the CSRO field of the Reverse Sync Follow-Up 
Information TLV. 

 

This is only a brief description of the main steps of Logical Syntonization. Sections 6.6.6 and 16.10 of the IEE1588-2019 

standard document describe the NRR and CSRO calculations and CSRO transmission format, including a few worked 

numerical examples. Sections 7.3.3 and 11.1 of the IEEE 802.1AS-2020 standard document define the process specific to 

802.1AS networks. Please refer to these documents for more details. 
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Appendix B. How does CAT Calculate CSRO, NRR and Peer Delay Turnaround Time? 
 

Paragon-X captures data for CAT to analyze and display. CAT calculates the Cumulative Scaled Rate Offset, Neighbour 

Rate Ratio and Peer Delay Turnaround Time numbers each time that a Peer Delay message exchange occurs. This 

appendix outlines the calculations. 

 

Cumulative Scaled Rate Offset (CSRO) 
 

CSRO is an encoding of the rateRatio calculated by each 802.1AS device. The rateRatio relates the local device clock to 

the Grand Master clock rate, so is a floating-point number with a value close to 1.0. CSRO is calculated using the formula 

CSRO = (rateRatio – 1.0) * 241 so CSRO is a signed integer that can be carried in a 32-bit field in Sync Follow-Up 

Information TLV messages. 

 

For Time Aware End Station measurements, CAT uses the CSRO values carried in Reverse Sync Follow-Up Information 

TLV messages to calculate the data that is displayed on the CSRO Delta graph: 
 

CSRO Delta = CSRO transmitted from Paragon-X master port – CSRO received in Reverse Sync messages. 
 

One CSRO Delta calculation is made on reception of every Sync Follow-Up or Reverse Sync Follow-Up message. 
 

Note that CSRO Delta is the difference between two encoded numbers so it’s practical use is to show that a device has 

calculated its local rateRatio. CAT decodes the CSRO numbers to rateRatio numbers before making NRR calculations.  

 

Time Aware End Stations should transmit their local rateRatio encoded to CSRO in the Reverse Sync Follow-Up 

messages. By default, the Paragon-X master transmits rateRatio = 1.0. The Paragon-X master CSRO parameter can be 

adjusted to simulate transmitting Sync Follow-Up messages where rateRatio is not exactly 1.0. 
 

 
Neighbour Rate Ratio (NRR) 

 

Peer Delay message exchanges occur in both directions allowing Paragon-X and the Time Aware End Station to 

calculate their own NRR values based on their local clocks. The Time Aware End Station uses its NRR to calculate its 

local rateRatio and adjust its clock scaling. If the Time Aware End Station makes these calculations and adjustments 

perfectly, its internal NRR will be the reciprocal of the NRR that Paragon-X measures. However, there is no standard 

mechanism for the Time Aware End Station to broadcast its internal NRR. 
 

The diagram below shows consecutive Peer Delay messages and the timestamps carried in each message (Follow-Up 

messages are omitted for clarity). 
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CAT calculates NRR measurements using the timestamps recorded by Paragon-X: 

• NRR (Actual) at the Paragon-X = (t8 – t4) / (t7 – t3)    

• NRR (DUT) is calculated from the rateRatio encoded as CSRO values in the Reverse Sync messages. 

• NRR Accuracy = NRR (Actual) – NRR (DUT) 
 

CAT displays the NRR measurements in ppm. 

 

CAT updates the NRR (DUT) graph once every Peer Delay message exchange. CAT displays the NRR (Actual) and NRR 

(Accuracy) graphs as moving averages over the NRR Period. CAT continues to calculate the NRR measurements using 

consecutive Peer Delay message exchanges for the duration of the test. 

 

 

Peer Delay Turnaround Time 
 

Paragon-X records timestamps from the Peer Delay messages that it initiates. CAT uses these timestamps, plus the 

cable delay, to calculate the Peer Delay turnaround time of the Time Aware End Station. The cable delay is the same in 

each direction and was provided when the Paragon-X master was configured. The diagram below shows the relevant 

timestamps and messages (Follow-Up messages are omitted for clarity). 

 

 
 

CAT calculates turnaround time using the timestamps recorded by Paragon-X: 

• Peer Delay Turnaround Time (Actual) = t4 – t1 – 2 * tcable 

• Peer Delay Turnaround Time (DUT) = t3 – t2 

• Peer Delay Turnaround Time Accuracy = Peer Delay Turnaround Time (Actual) – Peer Delay Turnaround Time (DUT) 
 

CAT displays Peer Delay Turnaround data in units of ns. 

 

CAT continues to calculate the Peer Delay Turnaround Time measurements for each Peer Delay message exchange that 

Paragon-X initiates for the duration of the test and plots the results on graphs. 
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